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Classroom Setup Instructions: CEHv6 
 
This document contains setup instructions for the EC-Council Certified Ethical Hacker (CEH) course.  The course requires 
a standard modular classroom seating configuration, one computer for each student, one computer for the instructor, one 
computer configured as an attack target (victim), a dedicated hub or switch (hub preferred), dedicated firewall, and 
Internet connection.  This class teaches network attack and penetration methodologies. It is imperative that network used 
for this class be separated both logically and physically from any other network in the training facility to preclude students 
“accidentally” conducting exploits on other computers within accessible networks.   

 
Before beginning the class, install and configure all computers using the information and instructions that follow. 
 
The information contained in this document is subject to change without notice.  Unless otherwise noted, the names of 
companies, products, people and data used in this document are fictional.  Their use is not intended in any way to 
represent any real company, person, product or event.  Users of this document are responsible for compliance with all 
applicable copyright laws.  No part of this document may be reproduced or transmitted by any means, electronic or 
mechanical, for any purpose, without the express written consent of the International Council of Electronic-Commerce 
Consultants, herein after referred to as the EC Council.  If, however, your only means of access is electronic, permission is 
hereby granted to print one copy. 
 
The EC-Council may have patents, patent applications, trademarks, copyrights or other intellectual property rights 
covering the material in this document.  Except as expressly provided in any written license agreement from the EC-
Council, providing this document does not give you any license to those patents, trademarks, copyrights or other 
intellectual property. 
 
EC-Council Certified Ethical Hacker and CEH are either registered trademarks or trademarks of the EC-Council in the 
USA and/or other countries. 
 
Other product and company names mentioned herein may be the trademarks of their respective owners. 
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Classroom Requirements 
This section describes classroom equipment required for the EC-Council Certified Ethical Hacker course.   
 

Classroom Equipment 

The following equipment is required for the general classroom setup: 
• Climate control system adjustable within the classroom 
• Lighting controls, adjustable within the classroom 
• Whiteboard, 3 feet X 6 feet (1m X 2m) or larger 
• Markers, whiteboard, assorted colors 
• Eraser, whiteboard 
• Cleaner, whiteboard, liquid, 3 oz minimum 
• Towels, paper 
• Easel with flipchart or butcher paper pad, 24 inches X 36 inches 
• Felt tip pens, blue and black required, other colors optional, chisel tip (not fine-point) 
• Screen, projection, 6 feet diagonal measurement (non-reflective whiteboard surface may be substituted) 
• Instructor station: 

o Desk 
o Chair, ergonomic 
o Power outlet 
o Network jack 
o Projector, LCD, capable of 740 X 1280 pixels minimum w/ all connecting cables 

• Student station (per student) 
o Chair, ergonomic 
o Workstation, minimum horizontal workspace 9 square feet (3 feet X 3 feet) 
o Outlet, power, one per student station 
o Network jack, one per student station 
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Hardware 
Hardware requirements for instructor, student and victim computers are identical: 

• Intel Dual Core or equivalent CPU with minimum CPU speed of 2.4 GHz 
• 2 GB or greater RAM 
• Hard disk, 40GB or larger, 7200 RPM or faster 
• CD-ROM/DVD drive (CD R/W drive preferred) 
• Network adapter, 10/100 Mb/s required, full duplex (disable any additional network adapters installed) 
• Super VGA (SVGA) monitor 17 inch 
• Mouse or compatible pointing device 
• Sound card with amplified speakers 
• Internet access 
• BIOS bootup configuration set to CD-ROM, Drive A, hard disk 1 (C: drive) 
• Wireless Network adapter (PCI or USB)1,2 

 
The following additional hardware is also required: 

• Hub or unmanaged switch (hub preferred), with sufficient ports to allow connection of all instructor and 
student workstations plus at least 5 additional, unused ports for connection of additional equipment or for 
use as “spares.”2     

• Hardware firewall appliance (Cisco PIX, ASA or equivalent) 2    
 

Software 
All computers in the class require the following software: 

 Windows 2003 Server (Standard or Enterprise Edition) 
• Adobe Acrobat Reader (from CEH tools CDs) 
• WinZip 8.1 (from CEH tools CDs) 

                                                
1 If wireless network adapters are not available for all classroom machines, at least the Instructor and Victim machines must be so equipped.   
2 Failure to provide this hardware will prevent students from conducting certain labs and degrade the learning experience.  If the student 

machines or classroom cannot be equipped with this hardware, the training facility should notify students that it cannot meet all hardware 
requirements for the class and that they will be unable to perform certain labs. 
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• VMWare (current licensed version)3 or Microsoft Virtual PC (current licensed version)4  
o Windows 2003 Server (Standard or Enterprise Edition), as guest OS configured with: 

o MS SQL Server 2000 
o MS Internet Information Server (IIS) 
o SNMP Services 

o Windows 2000 Server (Standard or Enterprise Edition), without service packs as a guest OS 
o Windows XP Professional as a guest OS 
o Fedora Core (latest version) as guest OS 
o CEH BackTrack (from CEH tools CDs) running as an ISO inside a virtual machine 

 
The instructor computer requires all software listed above AND the following additional software: 

 Dynamic Host Configuration Protocol (DHCP) Server 
 MS Word, PowerPoint and Excel (Office 2000, Office XP, Office 2003 or Office 2007 versions) 

 

Classroom Connectivity 
Because this class teaches network attack methodologies, it must be logically and physically separated from any other 
networks present in the training facility and must have its own connection to the Internet. 
 
 

Configuration 
This section describes the procedures for setting up the instructor, victim and student computers as well as general 
directions for the configuration of the firewall appliance. 
 
This guide assumes that you will use disk-imaging software to create images of the classroom computers for future use.  To 
that end, configuration tasks common to all computers are presented first.  Perform these tasks on the computer that will 

                                                
3 If your organization has not purchased VMWare Workstation, a trial copy can be downloaded from http://www.vmware.com.  You will need to 

register the copy in order to use it for the class.  You will need to download copies for each student in the class plus copies for the instructor and 
victim machines. 

4 A copy of Virtual Server 2005 is provided in the Module 00-Miscellaneous folder located on the CEHv6 Labs Volume 1 DVD-ROM. 
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become the Instructor computer.   Create a disk image after setting up a single student computer.  You may then deploy 
this image to remaining classroom machines while completing configuration of the Instructor computer.   
 
Because the Instructor computer is configured as a DHCP server that provides IP addresses to the student machines, the 
installation and configuration of the Instructor computer must be completed before final configuration of the student 
machines can begin.  The Victim machine uses a static IP address and so can be configured at any time after the base 
image has been deployed. 
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Setup Document overview 
This document provides background information for technical staff responsible for setting up a training room facility for 
the CEH course. This guide describes the requirements for the network equipment and computer stations that are 
installed and configured by the facilities personnel for the training courses. 
 
 

Training room environment 
The training room environment consists primarily of the following equipment: 
 

1. Student Computer 
2. Instructor Computer 
3. Victim machine 

 
 

Equipment Number 
(Class of 12 students) 

Operating  System 
 
 

Minimum 
System Requirements 

 
 
Student 
Workstations 
 

 
12 

 
Windows 2003 Server  
 

 
Intel Dual Core PC with 40 GB 
free disk space, 1GB RAM (2 GB 
preferred), 1 NIC 
(disable or unplug extras), 15-
inch monitor and cards to drive 
at 1024 x 768 (or at monitor’s 
native resolution) and configured 
at 16 million colors, and 
compatible mouse 
 

Instructor Station 1 Windows 2003 Server  
 

Intel Dual Core PC with 40 GB 
free disk space, 1GB RAM (2 GB 
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 preferred), 1 NIC 
(disable or unplug extras), 15-
inch monitor and cards to drive 
at 1024 x 768 (or at monitor’s 
native resolution) and configured 
at 16 million colors, and 
compatible mouse, Wireless Card 
for Wi-Fi access 
 

Victim Machine 
 

1 Windows 2003 Server 
running as HOST 
VMWARE Virtual Machines 
images: 

- Windows 2000 Server 
w/o SP 

- Windows XP 
- RedHat Linux Fedora 

 

Intel Dual Core PC with 40 GB 
free disk space, 1GB RAM (2 GB 
preferred), 1 NIC 
(disable or unplug extras), 15-
inch monitor and cards to drive 
at 1024 x 768 (or at monitor’s 
native resolution) and configured 
at 16 million colors, and 
compatible mouse 
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Instructor’s computer 
 
The instructor’s computer must: 
 

 Be installed with Windows 2003 Server  (Standard or Enterprise Edition) 
 Be installed with SQL Server 2000  
 Be running Microsoft Internet Information Server (IIS) 
 Be running IP protocol.   
 Be running SNMP services 
 Contain all hacking tools from the CEH v6 Lab Files DVD-ROMs resident on the hard drive in CEH tools folder at 

the Desktop (The lab files DVD-ROMs are available from CEH v6 courseware kit) 
 Contain all Windows 2003 source files in c:\i386 
 Have PowerPoint, Word and Excel installed (Microsoft Office 2000, XP or 2003 version) 
 Have Adobe Acrobat, WinZip installed (both can be found in Miscellaneous directory in CEH v6 Lab files DVD-

ROM) 
 Install “Command Prompt Here” extension (See CT Section) 
 Install Juggybank demo in SQL Server 2000 (See CT Section) 
 Remove the default “Internet Explorer Enhanced Security Configuration” utility in Control Panel -> Add/Remove 

Programs -> Windows Components  
 Disable DEP in Control Panel -> System -> Advanced -> Settings -> Data Execution Prevention 
 Download install Firefox browser 
 Install VMWare or Microsoft Virtual PC with (Windows 2000 Server w/o SP, Windows XP, BackTrack and STD) 
 Install Microsoft ISA Server on host machine with default settings 
 Install Wireless card (USB or PCI) 
 Have an Overhead Projector connected 
 Have a DVD-ROM as part of its hardware 
 Configure the logon account to username: administrator, password: password (lowercase) 
 Set Windows Explorer to show all files and file types and extensions. 
 Download the CEH desktop wallpaper from http://www.eccouncil.org/classroom/background.jpg and set up the 

downloaded image as Windows background wallpaper. 
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 The use of Ghost images is recommended to reduce setup time if computer failure occurs. If using Ghost, the 
Instructor’s computer should have a 40 GB hard drive that consists of a 4 GB FAT partition for WINNT and at least 
one other partition on which to store images of the computers.  
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Student workstations 
 
Student workstations must: 
 

 Be installed with Windows 2003 Server (Standard or Enterprise Edition) 
 Be installed with IIS 
 Be running IP   
 Contain all hacking tools from the CEH v6 Lab Files DVD-ROMs resident on the hard drive in CEH tools folder at 

the Desktop (The lab files DVD-ROMs are available from CEH v6 courseware kit) 
 Contain all Windows 2003 source files in c:\i386 
 Set Windows Explorer to show all files and file types. 
 Have Adobe Acrobat, WinZip installed (both can be found in Miscellaneous directory in CEH v6 Lab files DVD-

ROM) 
 Remove the default “Internet Explorer Enhanced Security Configuration” utility in Control Panel -> Add/Remove 

Programs -> Windows Components  
 Disable DEP in Control Panel -> System -> Advanced -> Settings -> Data Execution Prevention 
 Download install Firefox browser 
 Install “Command Prompt Here” extension 
 Install VMWare or Microsoft Virtual PC with (Windows 2000 Server, Windows XP, BackTrack and NST) 
 Configure the logon account to username: administrator, password: password (lowercase) 
 Install Matrix screen saver located in CEH v6 Lab files DVD-ROM\Miscellaneous directory – set the time to 

15 minutes. 
 Download the CEH desktop wallpaper from http://www.eccouncil.org/classroom/background.jpg and set up the 

downloaded image as Windows background wallpaper. 
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Victim workstation  
 
Victim workstation must: 

 Be installed with Windows 2003 Server (Standard edition) w/o SP 
 Be Installed with VMWare or Virtual PC with the following host images: 

o Windows XP Professional  
o Windows 2000 Server w/o SP 
o Redhat Linux Fedora 

 Be installed with SQL Server 2000  
 Be installed with IIS 
 Be running SNMP services 
 Be running IP  
 Contain all hacking tools from the CEH v6 Lab Files DVD-ROMs resident on the hard drive in CEH tools folder at 

the Desktop (The lab files DVD-ROMs are available from CEH v6 courseware kit) 
 Contain all Windows 2003 source files in c:\i386 
 Configure the logon account to username: administrator, password: password (lowercase) 
 Set Windows Explorer to show all files and file types. 
 

 
Room environment 

 The room must contain a whiteboard measuring a minimum of 1 yard by 2-3 yards in length (1 meter by 2-3 
meters). 

 The room should contain an easel and large tablet. 
 The room must be equipped with legible black and blue felt tip pens (CHISEL-Point, not fine-tip). 
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Classroom configuration 
The configuration of this classroom is modular. Computers can be added or removed by either row or column, depending 
on the needs of the particular class. The following is a sample room setup that provides optimal support. This setup allows 
for ease of access to "troublespots" by the instructor, and allows students to break into functional small and larger teams. 
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Set up the machines based on the classroom setup diagram. The lab exercises for the students are instructor led and they 
are based on the hacking tools in the trainer slides. The instructor is encouraged to demonstrate and guide the students on 
the usage of the hacking tools against the Victim’s computer. Do not encourage live hacking on the Internet using these 
tools in the classroom. Please feel free to include your own exercises. 
 

 
VMware and Guest OS Installation 
 

1. Install VMWare  
a. Install VMWare Workstation software on student and instructor machines.  Evaluation trial copy of 

VMWare is located at CD-ROM\Miscellaneous directory and VMWare’s website. 
b. You will need to register with VMWare at http://www.vmware.com to obtain the serial number. 
c. You can also download a trial version VMWare at http://www.vmware.com  

 
2. Install BackTrak Linux as Guest OS in VMWare 

a. Create a new Virtual Machine in VMWare and label it as BackTrack Linux. 
b. Configure VMWare Linux Virtual Machine’s Network settings to use Bridged – Connected directly to 

the Network. 
c. Configure Linux Virtual Machine’s CD-ROM settings to use iso image and point it to backtrack3.iso file. 

The BackTrack3.iso file is located in the CEH DVD-ROM. The iso file size is about 700MB.  
 

3. Install Windows 2000 Server as Guest OS in VMWare 
a. Create a second Virtual Machine and Label it as Windows 2000 Server. 
b. Install Windows 2000 Server without any SP on this virtual machine. Configure the computer name as: 

Victim-Win2K 
c. Configure the logon account to username: administrator, password: password (lowercase) 
d. Configure VMWare Windows 2000 Server Virtual Machine’s Network settings to use Bridged – 

Connected directly to the Network. 
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4. Install Windows XP as Guest OS in VMWare 
a. Create a third Virtual Machine in VMWare and label it as Windows XP SP2. 
b. Install XP with any service pack on this virtual machine. Configure the computer name as: Victim-XP 
c. Configure the logon account to username: administrator, password: password (lowercase) 

 
5. Install Security Tools Distribution (STD) as Guest OS in VMWare 

a. Create a fourth Virtual Machine in VMWare and label it as Security Tools Distribution. 
b. Configure VMWare Linux Virtual Machine’s Network settings to use Bridged – Connected directly to 

the Network. 
c. Configure Linux Virtual Machine’s CD-ROM settings to use iso image and point it to ceh-std.iso file. You 

can download the ceh-nst.iso at http://www.eccouncil.org/classroom/ceh-std.iso  
d. The file size of iso file is about 500MB 

 
6. Create Snapshot of Windows Virtual Machine in VMWare. Students will be able to restore the virtual PC state 

after completing exercises. 
7. Test the network by pinging the VMWare’s Virtual PC guest OS from the host computer and vice versa. 
8. Students can target the attacks on VMWare’s virtual PC as victim. 

 
You can also use Microsoft Virtual PC instead of VMware. Evaluation copy of Virtual PC can be 
downloaded from http://www.microsoft.com/virtualpc 
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Configure the network to use Bridged – Connected directly to the physical network. 
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Network topology 
The training room must be physically isolated from any production network. Students must be able to access the Internet 
from their PCs. All computers are connected as one isolated network and domain. The common protocol is IP. All 
computers should have dynamic IP addresses using DHCP server. Configure the DHCP server scope to 10.0.0.0/24 IP 
addresses. This reduces potential problems when booting from BackTrack. NICs can be 10Mbit or 100Mbit (100Mbit is 
recommended). Hub is recommended but not required instead of a switch (helpful for demonstrating tools in 
Sniffer/Session Hijacking  modules) Cables must be bundled and tied out of pathways and work areas, and of 
sufficient length as not to be under stress.  
 

Computer names 
Assign computer names to student machines like CEHSTUDENT1, CEHSTUDENT2, CEHSTUDENT3 and so on. 
Instructor machine should be named as INSTRUCTOR and victim machine as VICTIM. 
 

NDA document  
Download and print the student NDA document located at  
http://www.eccouncil.org/agreements/EthicalHacking-NDA.pdf  and have them ready for students to sign before the 
class starts on day 1.  
 
Note: DO NOT CONDUCT THE CLASS WITHOUT STUDENT SIGNING THIS DOCUMENT.  
ATC should file the NDA document at their facility. 
 
Instructor acceptance 
Before the training class is scheduled to begin, the instructor will visit the training facility to inspect and accept the setup. 
The technical contact (System Administrator) for the facility must be available to answer questions and correct any setup 
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issues. Both the instructor and the facility technical contact will ensure completion of the following checklists before the 
training setup is deemed acceptable.  
 
 
Firewall Settings 
Do not block any ports while accessing the Internet through the firewall. You should be able to ping servers on the Internet 
 

Blackboard 
Write the following on the blackboard top left corner. 

- Instructor name: <Name of the instructor> 
- Victim Win2003 IP: <Type IP from VM here> 
- Victim Win2000 IP: <Type IP from VM here> 
- Victim Fedora Linux: <Type IP from VM here> 
- The username/password to logon to the student machine. 
-  

At the center of the board write the following letters in bold. 
 

Welcome to CEHv6 Class! 
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Setup Checklist 
  
The arrangement of items in the setup checklists is designed to allow the process to be completed in the most efficient 
manner possible while still validating that the setup has been performed correctly.  Before beginning the setup checklist, 
log off any connected users. 
 
 

Tick 
Here 

List 

 
 

 
Open Network Neighborhood. Verify that all classroom computers are visible in Network Neighborhood. 
 

 Verify that the Windows OS source files are on the computer in c:\i386. 
 

 Verify that the hacking tools are on the computer in CEH tools folder at the Desktop. 
 

 Verify that Internet access is available. 
 

 Visit http://www.eccouncil.org and view the page to check Internet access. 
 

 Open Command Prompt and type nslookup certifiedhacker.com and look for connection to the server. 
 

 Verify Microsoft PowerPoint, Word, Excel are installed. 
 

 Verify Acrobat and Winzip and command prompt extensions are installed. 
 

 Verify that the Instructor computer can image through the overhead projector. 
 

 Verify each computer has 10 GB or more free disk space. 
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 Verify Windows Explorer is set to show all files and file type including hidden files and extensions. 
 

 Verify if you can successfully boot using Windows 2000, Windows XP, BackTrack, STD in VMware/Virtual 
PC. 
 

 Cable Wiring organized and labeled. 

 Student Workstations and chair placement satisfactory. 
 

 Placement of LCD (overhead) projector appropriate. 
 

 Whiteboard and dry erase markers and eraser are available. 
 

 Instructor station properly organized and oriented. 
 

 Computers are labeled with client number. 
 

 EC-Council courseware’s (Official EC-Council CEHv6 Box) available for students.  
 

 Student NDA agreement downloaded and printed for every student in the class and placed on each student 
desk. 
 

 Write down the facility’s technical contact person’s hand phone number. Contact him in case of network 
problem. 
 

 Verify the configuration of CEH wallpaper on the desktop – black background with CEH logo at the center. 
 

 Test the “Matrix” screen saver. 
 

 Verify DEP in Control Panel is disabled 
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 Verify that IE Security Configuration is removed from Add/Remove programs 
 

 Verify “Command Prompt Here” extension is installed 
 

 Verify Firefox Web Browser is installed 
 

 

 Notes 
 You might want to ghost the instructor, victim and student machine images so that future installations become 

easier 
 You can always replace corrupted systems files (exe and .dll) files from the c:\i386 directory during the class. Many 

Trojans and rootkits replace the systems files and you will need to restore them from this directory 
 Just have one additional student machine available as standby. If a student complains that he cannot boot up the 

computer because of virus/trojan infection, then you will be able to replace the student machine with this backup  
 
 

Instructor Acceptance 
The technical contact (System Administrator) for the facility must be available to answer questions and correct any setup 
issues.   

 

The Instructor will inspect both the classroom and the items covered in the setup checklist(s) to ensure that the classroom 
and setup meet EC Council standards.  Any deficiencies discovered by the Instructor must be corrected before the 
scheduled start time for the class.  

 
 

Assistance 
If you have problems or require assistance in setting up the Lab for your CEH class, please e-mail haja@eccouncil.org 
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Detailed Setup Instructions - Configuration Tasks (CT) 
 

CT#1:  Set up hardware 
1. Install the wireless network adapters according to manufacturer's instructions. 

2. Set the computer’s BIOS to start first from the CD-ROM drive then hard drive (Drive C:). 

3. Configure the hard disk as a single active primary partition formatted as FAT.   

 

CT#2:  Install Windows 2003 Server  
1. Insert the Windows 2003 Server STD compact disc into the CD-ROM drive. 

NOTE:  If your computer can start from the CD-ROM drive, restart the computer.  If the “Press any key to 
boot from CD” message appears, press SPACEBAR  and then proceed to step 5. 

2. Start the computer using an MS-DOS system disk. 

3. At the command prompt, type: x:\i386\winnt /s:x:\i386 (where x is the letter assigned to the CD-ROM 
drive), and press ENTER. 

4. When Setup indicates that the MS_DOS portion of Setup is complete, remove any disk from the floppy disk 
drive, and then press ENTER. 

5. On the Setup Notification screen, press ENTER. 

6. When the Windows 2003 Licensing Agreement appears, press F8 to accept the licensing terms. 

7. Setup displays a list of existing partitions and unpartitioned space. 

8. In the list of existing partitions, select C: Partition1 [FAT32] and press ENTER. 

9. If Setup notifies you that converting the partition to NTFS will make the drive unusable by other operating 
systems, press C to convert the partition to NTFS. 

10. Setup examines the hard disk and then copies files to the Windows 2000 installation folders. 

11. When Setup prompts you to restart the computer, leave the compact disc in the CD-ROM drive. 
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12. The computer restarts.  Setup converts drive C: to NTFS, and then the computer restarts a second time. 

14. After the computer restarts, the Windows 2000 Server Setup wizard appears and begins the GUI installation 
process. 

15. On the Regional Settings page, click Next. 

16. On the Personalize Your Software page, in the Name box, type CEH. 

17. In the Organization box, type EC Council and then click Next. 

18. On the Your Product Key page, type the Product Key for your organization’s copy of Windows 2003 
Server (STD), and then click Next. 

19. On the Licensing Modes page, in the Number of concurrent connections box, type 50 and then click 
Next. 

20. On the Computer Name and Administrator Password page, in the Computer Name box: 

 if you are configuring the physical machine, type CEHINSTRUCTOR 
 if you are configuring the Windows 2003 Server virtual machine, type Instructor. 

21. In the Administrator password and Confirm password boxes, type password and then click Next. 

22. When the Windows Setup dialog box appears, informing you that you have specified a password for the 
Administrator account that does not meet the criteria for strong passwords, click Yes. 

23. On the Date and Time Settings page, adjust the date, time, and time zone on your computer to conform 
to that of the local area, and then click Next. 

24. The Networking Settings page appears, informing you that Windows 2003 Server is installing networking 
components and then prompting you to choose typical or custom network settings. 

25. Click Typical  Settings and click Next. 

26. On the Workgroup or Computer Domain page, click Next to join the default workgroup. 

27. Windows 2003 Server finishes the installation and the computer restarts. 

28. Once the restart has completed, log on as Administrator with a password of password. 
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29. The Display Settings balloon appears informing you that the screen resolution and depth should be 
adjusted.  Click the balloon. 

30. In the Display Settings dialog, click Yes. 
31. In the Monitor Settings dialog, click Yes. 
32. In the Manage Your Server dialog, maximize the window and then enable the Don't display this page 

at logon box. 

33. Close the Manage Your Server window. 

NOTE:  If you are installing Windows 2003 Server on a physical machine, or installing Windows 2003 
Server as a guest operating system in Virtual PC, proceed to CT#3, Copy operating system files.  If you are 
installing Windows 2003 Server as a guest operating system inside VMWare, perform the following 
additional steps before proceeding to CT#3: 

34. Press <CTRL>+<ALT> to release cursor. 

35. In the VMWare menu, click VM and select Install VMWare tools from the popup menu. 

36. In the W2K3 – Virtual Machine dialog box, click Install. 
37. In the Welcome to the installation wizard for VMWare Tools window, click Next. 

38. In the Setup Type window, click Next as Typical is already selected. 

39. In the Ready to Install the Program window, click Install. 
40. If the VMWare Tools Installation dialog appears informing you that hardware acceleration is not enabled, 

click Yes and follow the directions provided in HWAccel.txt to modify the hardware acceleration settings. 

41. In the Installation Wizard Completed window, click Finish. 

42. In the VMWare Tools window, click Yes to restart the VM. 

43. After the VM has restarted, log on as Administrator with a password of password.  

44. Continue with CT#3, Copy operating system files below. 
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CT#3:  Copy operating system files 
1. Copy the i386 folder from the Windows 2003 Server CD to the root of drive C: (C:\). 

2. When completed, close all windows to return to the Desktop. 

 

CT#4a:  Install VMWare 
Note:  This setup guide shows how to install VMWare v5.5.  Installation of other versions will be similar. 

1. Double click on the VMWare-workstation executable. 

2. In the Welcome to the installation wizard for VMWare Workstation window, click Next. 

3. In the License agreement window, select Yes, I accept the terms in the license agreement and click 
Next. 

4. In the Destination Folder window, click Next to install VMWare in C:\Program Files\VMWare\VMWare 
Workstation. 

5. In the Configure Shortcuts window, click Next. 

6. In the Configure Product window, click Next to disable autorun. 

7. In The wizard is ready to begin installation window, click Install. 
8. In the Registration Information window, click Skip. 

9. In the Installation Wizard Completed window, click Finish. 

 

CT#4b:  Install Microsoft Virtual PC 
Note:  This setup guide shows how to install Virtual PC 2004.  Installation of other versions will be similar. 

1. Insert the Microsoft Virtual PC 2004 CD into the CD-ROM drive. 

2. If the installation does not start automatically, open Windows Explorer, navigate to the root of the CD-ROM 
drive, and double click on the setup.exe executable.  
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3. In the Welcome to the InstallShield Wizard for Microsoft Virtual PC 2004 window, click Next. 

4. In the License Agreement window, select I accept the terms in the license agreement and click Next. 

5. In the Customer Information window, enter your Product ID Key and then click Next as the User 
Name and Organization boxes are already populated and the install will be configured for anyone who uses 
this computer (All Users). 

6. In the Ready to Install the Program window, click Install to install Virtual PC in C:\Program 
Files\Microsoft Virtual PC. 

7. In the Installation Wizard Completed window, click Finish. 

 

CT#5a:  Install a Guest Operating System in VMWare↑ 
NOTE:  Steps 1-3 are performed only for the first virtual machine created.  When creating the second and 
subsequent virtual machines, begin with step 4. 

NOTE:  Fedora Core Linux has special requirements for VMWare installation and is not included in this CT.  
When ready to install Fedora Core Linux, perform CT#18. 

7. Double click on the VMWare Workstation shortcut on the Desktop. 

8. In the Tip of the Day window, deselect Show tips at startup and click Close. 

9. If the VMWare Web Check window appears indicating that there is an update to the installed version of 
VMWare workstation, click Cancel. 

10. On the VMWare Menu, click File�New�Virtual Machine. 

11. In the Welcome to the New Virtual Machine Wizard, click Next. 

12. In the Select the Appropriate Configuration window, click Next as Typical is already selected. 

13. In the Select a Guest Operating System window: 

If configuring Choose 

Windows Server Microsoft Windows 
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2003 

Windows 2000 
Server 

Microsoft Windows 

Windows XP Microsoft Windows 

Live CD Linux 
 

14. In the Select a Guest Operating System window, version drop down box: 

If configuring Choose 

Windows Server 
2003 

Windows Server 2003 
Standard Edition 

Windows  2000 
Server 

Windows 2000 Server 

Windows XP Windows XP Professional 

Live CD Other Linux 
and then click Next.   
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15.  In the Name the Virtual Machine window, Virtual machine name box: 

If configuring Type 

Windows Server 
2003 

W2K3 

Windows Server 
2000 

W2K 

Windows XP XP 

Live CD Live 
and then click Next. 
 

16. In the Network Type window, click Next as Use bridged networking is already selected. 

17. In the Specify Disk Capacity window, click Finish as the default disk size of 8.0 GB is already 
selected. 

18. In the virtual machine tab, Commands section, click Edit virtual machine settings. 

19. Click the Options tab. 

20. In the Options tab, Settings window, click on Snapshots. 

21. In the Options tab, When powering off section, click Ask me and then click OK. 

22. In the virtual machine tab, Commands section, click Start this virtual machine. 

23. Immediately after the virtual machine's window turns black and the VMWare logo appears in the window, 
click on the VMWare logo to set the cursor focus inside the virtual machine and then press F2 to enter the 
BIOS setup options. 

24. In the PhoenixBIOS Setup Utility, use the arrow keys on the keyboard to move to the Boot section of the 
utility. 

25. Use the down arrow key on the keyboard to select CD-ROM drive. 
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26. Press the plus (+) key on the keyboard to move CD-ROM to the top of the list and then press the F10 
key. 

Note:  If you are configuring the “Live CD” VMWare machine, no further configuration is necessary.  Shut 
down the virtual machine and save a snapshot if asked to do so.  If configuring any other VMWare image, 
continue with step 21 below. 

27. Insert an MS-DOS startup disk, Windows 9x Startup disk or partitioning utility into the floppy or CD-ROM 
drive. 

28. In the Setup Confirmation window, press ENTER as the Yes entry is already selected to save the new 
configuration. 

29. Create a single primary active partition within the virtual machine using the entire capacity of the virtual 
hard drive and format the partition with FAT 32. 
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30. Install the guest operating system by using the appropriate CT below: 
 

If installing: Use: 

Windows Server 
2003 

CT#2 

Windows 2000 
Server 

CT#16 

Windows XP CT#17 

Fedora Core CT#18 

  
31. Repeat steps 4-24 for each additional Windows-based guest operating system to be installed.  To install 

Fedora Core Linux, perform CT#18 instead of steps 2-24 above. 

 

CT#5b:  Install Windows 2003 Server as a Guest Operating System in Virtual 
PC 

1. If other virtual machines are installed on the host, the Virtual PC Console appears.  Click New. 

2. In the Welcome to the New Virtual Machine Wizard, click Next. 

3. In the Options window, click Next as the Create a virtual machine option is already selected. 

4. In the Virtual Machine Name and Location window, name and location: box, name the guest operating 
system Windows 2003 Server and then click Next. 

5. In the Operating System window, click on the drop down arrow in the Operating system: box and select 
Windows 2003 Server, then click Next.. 

6. In the Memory window, click Next as the selection for using the recommended RAM is already selected. 
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7. In the Virtual Hard Disk Options window, select A new virtual hard disk and then click Next. 

8. In the Virtual Hard Disk Location window, click Next. 

9. In the Completing the New Virtual Machine Wizard, click Finish. 

10. In the Virtual PC Console, click Settings. 

11. In the Settings window, click Undo Disks. 

12. In the Undo Disks pane, click Enable undo disks to enable this feature and then click OK. 

13. In the Virtual PC Console, click Windows 2003 Server if it is not already selected and click Start. 

14. In the Windows 2003 Server Microsoft Virtual PC 2004 window Menu, click CD. 

15. From the drop down menu, select Use Physical Drive D: 

16. Insert an MS-DOS startup disk, Windows 9x Startup disk or partitioning utility into the floppy or CD-ROM 
drive. 

17. Create a single primary active partition within the virtual machine using the entire capacity of the virtual 
hard drive and format the partition with FAT 32. 

18. Install Windows 2003 Server (Standard Edition) as described in CT#2. 

 

CT#6:  Copy courseware files 
1. Create a folder on the Desktop named CEH_Tools. 

2. Insert the CEH v6 Labs Volume 1 DVD discs into the DVD-ROM drive, and then copy the contents of the 
compact disc to the CEH_Tools folder. 

3. Repeat this procedure for CEH v1 Labs Volume 2-4. 

Note:  When copying these additional CDs, if you are informed that files already exist at the destination, choose to 
overwrite any existing files. 
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CT#7:  Install and Configure Simple Network Management Protocol (SNMP) 
Services  

Note:  This task takes place inside the Windows 2003 Server Virtual Machine. 

1. Start|Control Panel|Add or Remove Programs. 

2. In the Add or Remove Programs window, click on Add/Remove Windows Components. 

3. In the Windows Components Wizard, Components window, scroll to and select Management and 
Monitoring Tools and then click Details.  Do not click the check box to the left of management and 
Monitoring Tools.  

4. In the Management and Monitoring Tools window, Subcomponents window, click the check box to the 
left of Simple Network Management Protocol and click OK. 

5. In the Windows Components window, click Next. 

6. If the Insert Disk dialog appears, asking you to insert the Windows Server 2003 Compact Disc, click OK. 

7. In the Files Needed window, Copy files from: drop down, change the displayed location to C:\i386 and 
click OK. 

8. In the Completing the Windows Components Wizard window, click Finish. 

9. Close the Add or Remove Programs window. 

10. Start|Programs|Administrative Tools|Computer Management. 

11. In the Computer Management Console, expand Services and Applications. 

12. Click on Services. 

13. In the right pane of the Console, scroll to SNMP Service. 

14. Right click on SNMP Service and select Properties from the pop up menu. 

15. Click on Security Tab. 

16. In the Accepted Community Names section, click Add. 
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17. In the SNMP Service Configuration window, type Public in the Community Name box for Community 
Rights:  READ ONLY and click Add.. 

18. In the Accepted Community Names section, click Add. 

19. In the SNMP Service Configuration window, click the drop down arrow in the Community Rights box 
and select READ WRITE. 

20. In the Community Name box, type Private and then click Add. 

21. Select Accept SNMP packets from any host and then click Apply and OK. 

22. Close Computer Management Console. 

 

CT#8:  Install Internet Information Services (IIS)  
1. Click on Start|Control Panel|Add or Remove Programs. 

2. In the Add or Remove Programs window, click on Add/Remove Windows Components. 

3. In the Windows Components window, click the check box to the left of Application Server.  This will 
install the Application Server Console, Enable network COM+ access and install IIS Common Files, Internet 
Information Services Manager and World Wide Web Service. 

4. In the Windows Components Wizard window, unselect Internet Explorer Enhanced Security 
Configuration and click Next. 

23. If the Insert Disk dialog appears, asking you to insert the Windows Server 2003 Compact Disc, click OK. 

24. In the Files Needed window, Copy files from: drop down, change the displayed location to C:\i386 and 
click OK. 

5. When the Completing the Windows Components Wizard window appears, click Finish. 

6. Close the Add or Remove Programs Window. 

 

CT#9:  Install MS SQL Server 2000 
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1. Insert the MS SQL Server 2000 (Enterprise Edition) CD into the CD-ROM drive. 

2. When the Microsoft SQL Server 2000 Enterprise Edition splash page appears, click SQL Server 
2000 Components. 

3. In the Install Components splashscreen, click Install Database Server. 

4. In the SQL Server 2000 SP2 and below window, click Continue. 

5. In the Microsoft SQL Server Installation Wizard Welcome screen, click Next. 

6. In the Computer Name window, click Next to install SQL server on the local computer. 

7. In the Installation Selection window, click Next to create a new instance of SQL Server or install 
Client Tools. 

8. In the User information window, click Next as the Name: Instructor and Company:  EC Council should 
already appear in the respective boxes.  If this information is missing, type the appropriate entry in the 
appropriate boxes and then click Next. 

9. In the Software License Agreement window, click Yes. 

10. In the Installation Definition window, select Server and Client Tools and then click Next. 

11. In the Instance Name window, click Next. 

12. In the Setup Type window, select Typical and click Next. 

13. In the Services Accounts window: 

14. Select Use the same account for each service.  Auto start SQL Server Service. 
15. Under Service Settings, select Use the Local System account and then click Next. 
16. In the Authentication Mode window, select Mixed Mode (Windows Authentication and SQL 

Server Authentication) 
17. Select Blank password (not recommended) and click Next. 

18. In the Start Copying Files window, click Next. 

19. In the Choose Licensing Mode window, select Per seat for: and type 50 in the processors box.  Click 
Continue. 



EC-Council 

CEH v6 Instructor Lab Setup Guide       42 

20. In the Setup Complete window, click Finish. 

 

CT#10:  Configure the JuggyBank Website 
1. Open the CEH_Tools folder on the Desktop. 

2. Open the Module 19 – SQL Injection folder. 

3. Copy the Sql demo scripts folder to the root of drive C: (C:\). 

4. Rename the Sql demo scripts folder to sql. 
5. Right click on the sql folder and select Sharing and Security from the pop up menu. 

6. Click on the Security tab. 

7. Beneath the Group or user names box, click Add. 

8. In the Select User or Groups window, click Advanced. 

9. Click the Find Now button to the right of the Common Queries section. 

10. In the Search results window scroll to the IUSR_INSTRUCTOR account and select it.   

11. Click the OK button above the Search results window. 

12. In the Select Users or Groups window, click OK. 

13. In the sql Properties window, click OK. 

14. Right click on the sql folder and select Sharing and Security from the pop up menu. 

15. Click on the Web Sharing tab. 

16. In the Web Sharing tab, ensure that the sql folder appears in the Aliases window, that the Share this 
folder option is selected and that the Share on drop down lists the Default Web Site. 

17. Click on sql in the Aliases window and then click Edit Properties. 

18. In the Edit Alias window, Access permissions section, ensure that Directory browsing is enabled and 
then click OK. 
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19. In the sql Properties window, click OK. 

20. Close Windows Explorer to return to the Desktop. 

21. Start|Administrative Tools|Internet Information Service (IIS) Manager. 

22. Expand Instructor (Local Computer). 

23. Click Web Service Extensions in the left pane of the Console Root. 

24. Select Active Server Pages in the right pane of the Console Root and click Allow. 

25. Expand Web Sites in the left pane of the Console Root. 

26. Right click on the Default Web Site and choose Properties from the pop up menu. 

27. In the Default Web Site Properties window, click on the Home Directory tab. 

28. Click the Browse button next to the Local Path: box. 

29. In the Browse for folder window, select C:\sql and click OK and then click OK again to close the Default Web 
Site Properties. 

30. Expand Default Web Site. 

31. Right click on the sql icon beneath Default Web Site and select Properties from the pop up menu. 

32. In the sql Properties window, click on the Directory Security tab. 

33. On the Directory Security tab, in the Authentication and access control section, click Edit. 

34. In the Authentication Methods window, Select Enable anonymous access , click OK and then click 
OK again to close the sql Properties window. 

35. Close Internet Information Services (IIS) Manager window. 

36. In the sql Properties window, click on the Web Sharing tab. 

37. Navigate to Start|All Programs|Microsoft SQL Server|Enterprise Manager. 

38. In the Console Root\Microsoft SQL Servers window, expand Microsoft SQL Servers. 

39. Expand Microsoft SQL Servers. 
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40. If there are no SQL servers listed in the group, perform the following steps, else go to step 15. 

(a)  Right click SQL Server Group and select New SQL Server Registration from the pop up 
menu. 

(b)  In the Welcome to the Register SQL Server Wizard window, click Next. 

(c)  In the Select a SQL Server window, Available servers: section, INSTRUCTOR is listed as an 
available server.  Click Add and then click Next. 
(d)  In the Select an Authentication Mode window, click Next as “The Windows account 
information I use to lo on to my computer (Windows Authentication) is already selected” and click 
Next. 

(e)  In the Select SQL Server Group window, click Next as “Add the SQL Server(s) to an existing 
SQL Server group is already selected and  “SQL Server Group” already appears in the Group name: 
box. 

(f)  In the Completing the Register SQL Server Wizard window, click Finish. 

(g)In the Register SQL Server Messages window, when the status shows “INSTRUCTOR – 
Registered successfully”, click Close. 

41. Right click on INSTRUCTOR (Windows NT) and select Properties from the pop up menu. 

42. In the SQL Server Properties (configure) window, click the Security tab. 

43. In the Security tab, Security section, Authentication option, ensure that SQL Server and Windows is 
selected and then click OK. 

44. Expand INSTRUCTOR (Windows NT). 

45. Expand Databases. 

46. In the SQL Enterprise Manager Menu, click Tools and select SQL Query Analyzer from the drop 
down menu. 

47. In the Connect to SQL Server window, SQL Server drop down, if INSTRUCTOR does not appear, select 
it from the drop down box or use the navigate button to locate INSTRUCTOR or (local). 

48. In the Connect using section, select SQL Server authentication and click OK. 
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49. Maximize the Query – INSTRUCTOR.master.sa – Untitled1 window. 

50. Close the Object Browser. 

51. In the SQL Query Analyzer Menu, click File and select Open from the drop down menu. 

52. In the Open Query File window, navigate to C:\sql\Data and open juggybank.sql. 
53. In the SQL Query Analyzer Menu, click Query and select Execute from the drop down menu. 

54. After the query has executed successfully, close the SQL Query Analyzer window. 

55. In the SQL Server Enterprise Manager Console Root, right click on the Databases folder and select 
Refresh from the pop up menu. 

56. Right click on the juggybank database and select All Tasks|Import Data from the pop up menu. 

57. In the Data Transformation Services Import/Export Wizard, click Next. 

58. In the Choose a Data Source window, Data Source drop down, select Text File. 

59. To the right of the File name: entry box, click the navigation button. 

60. Navigate to C:\sql\Data and open the juggybank-userinfo-data.txt file. 

61. In the Choose a Data Source window, click Next. 

62. In the Select file format window, click Next. 

63. In the Specify Column Delimiter window, click Next. 

64. In the Choose a destination window, Database drop down, select juggybank and then click Next. 

65. In the Select Source Tables and Views window, Destination column, click on 
[juggybank].[dbo].[jugg.. entry to select it. 

66. From the drop down box, select [juggybank].[dbo].[userinfo] and then click Next. 

67. In the Save, schedule, and replicate package window, click Next. 

68. In the Completing the DTS Import/Export Wizard, click Finish. 

69. In the DTS Import/Export Wizard notification window, click OK. 
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70. In the DTS Import/Export Wizard notification window, click OK. 

71. In the Executing Package window, click Done. 

72. Right click on the juggybank database and select All Tasks|Import Data from the pop up menu. 

73. In the Data Transformation Services Import/Export Wizard, click Next. 

74. In the Choose a Data Source window, Data Source drop down, select Text File. 

75. To the right of the File name: entry box, click the navigation button. 

76. Navigate to C:\sql\Data and open the juggybank-creditcard-data.txt file. 

77. In the Choose a Data Source window, click Next. 

78. In the Select file format window, click Next. 

79. In the Specify Column Delimiter window, click Next. 

80. In the Choose a destination window, Database drop down, select juggybank and then click Next. 

81. In the Select Source Tables and Views window, Destination column, click on 
[juggybank].[dbo].[jugg.. entry to select it. 

82. From the drop down box, select [juggybank].[dbo].[CreditCard] and then click Next. 

83. In the Save, schedule, and replicate package window, click Next. 

84. In the Completing the DTS Import/Export Wizard, click Finish. 

85. In the DTS Import/Export Wizard notification window, click OK. 

86. In the DTS Import/Export Wizard notification window, click OK. 

87. In the Executing Package window, click Done. 

88. Expand the juggybank database and click on the Tables object. 

89. Right click on the CreditCard table and select Open Table|Return All Rows from the pop up menu. 

90. Ensure that the table has been populated and then close the table. 

91. Right click on the userinfo table and select Open Table|Return All Rows from the pop up menu. 
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92. Ensure that the table has been populated and then close the table. 

93. Close SQL Server Enterprise Manager. 

94. Start|Administrative Tools|Data Sources (ODBC) 

95. In the ODBC Data Source Administrator, click  the System DSN tab. 

96. In the ODBC Data Source Administrator System DSN tab, a System Data Source for the LocalServer using 
SQL Server should be displayed.  If not, click Add, select SQL Server from the drivers list, and click Finish. 

97. In the Create a New Data Source to SQL Server window, in the Name:  entry box, type juggybank. 

98. In the Create a New Data Source to SQL Server window, in the Which SQL server do you want to 
connect to:  entry box, use the drop down to select INSTRUCTOR and then click Next. 

99. In the Create a New Data Source to SQL Server window, in the “How should SQL server verify 
the authenticity of the login ID?”, select  “With SQL server authentication using a login ID and 
password entered by the user.”  

100. In the Create a New Data Source to SQL Server window, in the Login ID entry box, remove 
any entry, type sa and then click Next. 

101. In the Create a New Data Source to SQL Server window, in the Change the default database 
to drop down, select juggybank from the list and then click Next. 

102. In the Create a New Data Source to SQL Server window, click Finish. 

103. In the ODBC Microsoft SQL Server Setup window, click on Test Data Source. 

104. Ins the SQL Server ODBC Data Source Test window, click OK. 

105. In the ODBC Microsoft SQL Server Setup window, click  OK. 

106. In the ODBC Data Source Administrator window, click OK. 

107. Open Internet Explorer. 

108. In the Internet Explorer Address Bar, type //localhost/sql and press ENTER. 

109. On the http://localhost/sql directory page, click on client.htm. 

110. On the JuggyBank website page, scroll down until the Login and Password entry boxes are visible. 
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111. In the Login entry box, type baduser  

112. In the Password entry box, type password and click on the Submit button. 

113. If the AutoComplete dialog appears asking you if you want Windows to remember this password, click 
in the check box to the left of “Don't offer to remember any more passwords” and click No. 

114. You are redirected to http://localhost/sql/badlogon.asp and informed that Access is Denied. 

115. Click the Back button in Internet Explorer to return to the JuggyBank Login page. 

116. In the Login entry box, type joker  

117. In the Password entry box, type joker and click on the Submit button. 

118. You are redirected to http://localhost/sql/ebanking.asp and the account information for Francis Q.  
Demo is displayed. 

119. Close the JuggyBank web page to return to the Desktop. 

 

CT#11:  Install Adobe Acrobat Reader 
1. Open the CEH folder on the Desktop. 

2. Open the Module 00 – Miscellaneous folder. 

3. Open the Adobe Reader folder. 

4. Double click on AcroReader51_ENU.exe to begin the installation. 

5. Complete the install by choosing defaults throughout the installation process. 

6. Alternatively, you can also install the latest Acrobat Reader from Adobe website. 

 

CT#12:  Install WinZip v8.1 
1. Open the CEH folder on the Desktop. 

2. Open the Module 00 – Miscellaneous folder. 
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3. Double click on winzip81.exe to being the installation. 

4. In the WinZip 8.1 SR-1 Setup window, click Setup. 

5. Complete the install by choosing defaults throughout the installation process.  Note:  Choose “Classic” when 
asked which interface you want to use as the default. 

6. After completing the install, the WinZip Tip of the Day window automatically opens.  From the drop 
down box in the lower left corner of the window, select Never show tips at startup and then click Close. 

7. Close the WinZip application. 

 

CT#13  Install Command Prompt Here shell extension 
1. Open the CEH folder on the Desktop. 

2. Open the Module 00 – Miscellaneous folder. 

3. Right click on DOSHERE.inf 

4. Select Install from the pop up menu. 

 

CT#14:  Configure Windows Explorer 
1. Start|Windows Explorer. 

2. In the Windows Explorer Menu, click Tools and select Folder Options from the drop down menu. 

3. In the Folder Options window, click the View tab. 

4. In the Advanced Settings window, under Hidden files and folders, select Show hidden files and 
folders, unselect Hide extensions for known file types and unselect Hide protected operating system files 
(Recommended) and then click OK. 

 

CT#15:  Install CEH Wallpaper 
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1. Open Internet Explorer and point to http://www.eccouncil.org/classroom/background.jpg  

2. Right click on the image and select Save Picture As from the pop up menu. 

3. In the Save Picture window, click Save. 

4. Close Internet Explorer. 

5. On the Desktop, right click and select properties from the pop up menu. 

6. In the Display Properties window, click on the Desktop tab. 

7. On the Desktop tab, click the Browse button. 

8. In the Browse window, select background.jpg and click Open. 

9. In the Display Properties window, click Apply and then OK. 

 

CT#16:  Install Windows 2000 Server as a guest operating system 
1. Insert the Windows 2000 Server STD compact disc into the CD-ROM drive. 

NOTE:  If your computer can start from the CD-ROM drive, restart the computer.  If the “Press any key to 
boot from CD” message appears, press SPACEBAR  and then proceed to step 5. 

2. Start the computer using an MS-DOS system disk. 

3. At the command prompt, type: x:\i386\winnt /s:x:\i386 (where x is the letter assigned to the CD-ROM 
drive), and press ENTER. 

4. When Setup indicates that the MS_DOS portion of Setup is complete, remove any disk from the floppy disk 
drive, and then press ENTER. 

5. On the Setup Notification screen, press ENTER. 

6. When the Windows 2000 Licensing Agreement appears, press F8 to accept the licensing terms. 

7. Setup displays a list of existing partitions and unpartitioned space. 

8. In the list of existing partitions, select C: FAT32 and press ENTER. 

9. In the Windows 2000 Server Setup screen, choose to convert the partition to NTFS and press ENTER.. 
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10. If Setup notifies you that converting the partition to NTFS will make the drive unusable by other operating 
systems, press C to convert the drive to NTFS. 

11. Setup examines the hard disk and then copies files to the Windows 2000 installation folders. 

12. When Setup prompts you to restart the computer, leave the compact disc in the CD-ROM drive. 

13. The computer restarts.  Setup converts drive C: to NTFS, and then the computer restarts a second time. 

14. After the computer restarts, the Windows 2000 Server Setup wizard appears and begins the GUI installation 
process. 

15. On the Regional Settings page, click Next. 

16. On the Personalize Your Software page, in the Name box, type CEH. 

17. In the Organization box, type EC Council and then click Next. 

18. On the Your Product Key page, type the Product Key for your organization’s copy of Windows 2000 
Server (STD), and then click Next. 

19. On the Licensing Modes page, in the Number of concurrent connections box, type 50 and then click 
Next. 

20. On the Computer Name and Administrator Password page, in the Computer Name box, type 
W2KI. 

21. In the Administrator password and Confirm password boxes, type password and then click Next. 

22. In the Windows 2000 Components page, click Next. 

23. On the Date and Time Settings page, adjust the date, time, and time zone on your computer to conform 
to that of the local area, and then click Next. 

24. The Networking Settings page appears, informing you that Windows 2000 Server is installing networking 
components and then prompting you to choose typical or custom network settings. 

25. Click Typical  Settings and click Next. 

26. On the Workgroup or Computer Domain page, click Next to join the default workgroup. 

27. When the Completing Windows 2000 Setup page appears, click Finish. 
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28. Once the restart has completed, log on as Administrator with a password of password. 
29. In the Windows 2000 Configure Your Server dialog, select I will configure this server later, and 

then click Next. 

30. In the Configure Your Server dialog, unselect Show this screen at startup and then close the 
Configure Your Server window. 

31. Close the Manage Your Server window. 

32. Press <CTRL>+<ALT> to release cursor. 

33. In the VMWare menu, click VM and select Install VMWare tools from the pop up menu. 

34. In the W2K – Virtual Machine dialog box, click Install. 
35. In the Welcome to the installation wizard for VMWare Tools window, click Next. 

36. In the Setup Type window, click Next as Typical is already selected. 

37. In the Ready to Install the Program window, click Install. 
38. If the VMWare Tools Installation dialog appears informing you that hardware acceleration is not enabled, 

click Yes and follow the directions provided in HWAccel.txt to modify the hardware acceleration settings. 

39. In the Installation Wizard Completed window, click Finish. 

40. In the VMWare Tools window, click Yes to restart the VM. 

41. After the VM has restarted, log on as Administrator with a password of password.  

42. Right click on the Desktop and choose Properties from the pop up menu. 

43. In the Display Properties window, click the Settings tab. 

44. In the Display Properties window, Settings tab, screen area section, move the slider until the screen 
area is 600 x 800 pixels, then click Apply. 

45. If the Display Properties dialog opens, informing you that your display settings are about to be applied, 
click OK. 

46. In the Monitor Settings dialog, click OK. 
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47. If the Monitor Settings dialog opens, asking if the settings are correct, click OK. 
48. In the Display Properties window, click OK. 

49. Click Start and select Shut Down from the menu. 

50. In the Shutdown Windows window, select Shut Down from the drop down box and then click OK. 

51. If the W2K – Virtual Machine dialog appears asking if you want to Just Power Off or Take a Snapshot, 
choose Take a Snapshot. 

52. Installation and configuration of the Windows 2000 Server VMWare guest operating system is now 
complete.  Return to CT#5a to install additional VMWare guest operating systems. 

 

 

CT#17:  Install Windows XP as a guest operating system 
1. Insert the Windows XP Professional compact disc into the CD-ROM drive. 

NOTE:  If your computer can start from the CD-ROM drive, restart the computer.  If the “Press any key to 
boot from CD” message appears, press SPACEBAR  and then proceed to step 5. 

2. Start the computer using an MS-DOS system disk. 

3. At the command prompt, type: x:\i386\winnt /s:x:\i386 (where x is the letter assigned to the CD-ROM 
drive), and press ENTER. 

4. When Setup indicates that the MS_DOS portion of Setup is complete, remove any disk from the floppy disk 
drive, and then press ENTER. 

5. On the Setup Notification screen, press ENTER. 

6. When the Windows XP Professional Licensing Agreement appears, press F8 to accept the licensing terms. 

7. Setup displays a list of existing partitions and unpartitioned space. 

8. In the list of existing partitions, select C: FAT32 and press ENTER. 

9. In the Windows XP Professional Setup screen, choose to convert the partition to NTFS and press 
ENTER.. 
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10. If Setup notifies you that converting the partition to NTFS will make the drive unusable by other operating 
systems, press C to convert the drive to NTFS. 

11. Setup examines the hard disk and then copies files to the Windows 2000 installation folders. 

12. When Setup prompts you to restart the computer, leave the compact disc in the CD-ROM drive. 

13. The computer restarts.  Setup converts drive C: to NTFS, and then the computer restarts a second time. 

14. After the computer restarts, the Windows XP Professional Setup wizard appears and begins the GUI 
installation process. 

15. On the Regional and Language Options page, click Next. 

16. On the Personalize Your Software page, in the Name box, type CEH. 

17. In the Organization box, type EC Council and then click Next. 

18. On the Your Product Key page, type the Product Key for your organization’s copy of Windows XP 
Professional, and then click Next. 

19. On the Computer Name and Administrator Password page, in the Computer Name box, type XPI. 

20. In the Administrator password and Confirm password boxes, type password and then click Next. 

21. On the Date and Time Settings page, adjust the date, time, and time zone on your computer to conform 
to that of the local area, and then click Next. 

22. The Networking Settings page appears, informing you that Windows XP Professional is installing 
networking components and then prompting you to choose typical or custom network settings. 

23. Click Typical  Settings and click Next. 

24. On the Workgroup or Computer Domain page, click Next to join the default workgroup. 

25. If the Display Settings dialog appears, informing you that your display settings will be automatically 
adjusted, click OK. 

26. When the Monitor Settings dialog appears informing you that your display settings have been adjusted, 
click OK>. 

27. When the Completing Windows XP Professional Setup page appears, click Finish. 
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28. Once the restart has completed, log on as Administrator with a password of password. 
29. If the Display Settings balloon appears, informing you that your display settings need adjustment, Close 

the balloon. 

30. Press <CTRL>+<ALT> to release cursor. 

31. In the VMWare menu, click VM and select Install VMWare tools from the pop up menu. 

32. In the XPI – Virtual Machine dialog box, click Install. 
33. In the Welcome to the installation wizard for VMWare Tools window, click Next. 

34. In the Setup Type window, click Next as Typical is already selected. 

35. In the Ready to Install the Program window, click Install. 
36. If the VMWare Tools Installation dialog appears informing you that hardware acceleration is not enabled, 

click Yes and follow the directions provided in HWAccel.txt to modify the hardware acceleration settings. 

37. In the Installation Wizard Completed window, click Finish. 

38. In the VMWare Tools window, click Yes to restart the VM. 

39. After the VM has restarted, log on as Administrator with a password of password.  

40. When the Display Settings balloon appears, informing you that your display settings need adjustment, 
click OK. 

41. If the Display Properties dialog opens, informing you that your display settings are about to be changed, 
click OK. 

42. If the Monitor Settings dialog opens, asking if the settings are correct, click OK. 
43. Click Start Shut Down Computer from the menu. 

44. In the Turn Off Computer window, click Turn Off from the drop down box and then click OK. 

45. If the XPI – Virtual Machine dialog appears asking if you want to Just Power Off or Take a Snapshot, 
choose Take a Snapshot. 

46. Installation and configuration of the Windows XP Professional VMWare guest operating system is now 
complete.  Return to CT#5a to install additional VMWare guest operating systems. 



EC-Council 

CEH v6 Instructor Lab Setup Guide       56 

 

 

CT#18:  Install Fedora Core as a guest operating system 
 

1. Double click on the VMWare Workstation shortcut on the Desktop. 

2. On the VMWare Menu, click File�New�Virtual Machine. 

3. In the Welcome to the New Virtual Machine Wizard, click Next. 

4. In the Select the Appropriate Configuration window, select Custom and then click Next. 

5. In the Select a Virtual Machine Format window, click Next as New – Workstation 5 is already selected. 

6. In the Select a Guest Operating System window, Guest operating system section, select  Linux. 

7. In the Select a Guest Operating System window, version drop down box, select RedHat Linux and then 
click Next.   

8. In the Name the Virtual Machine window, Virtual machine name box, type LINI and then click 
Next. 

(h)In the Processor Configuration window, click Next. 

9. In the Memory for the Virtual Machine window, click Next. 

10. In the Network Type window, click Next. 

11. In the Select I/O Adapter Types window, click Next. 

12. In the Select a Disk window, click Next. 

13. In the Select a Disk Type window, select IDE and then click Next. 

14. In the Specify Disk Capacity window, click Next. 

15. In the Specify Disk File window, click Finish. 

16. In the virtual machine tab, Commands section, click Edit virtual machine settings. 
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17. Click the Options tab. 

18. In the Options tab, Settings window, click on Snapshots. 

19. In the Options tab, When powering off section, click Ask me and then click OK. 

20. In the virtual machine tab, Commands section, click Start this virtual machine. 

21. Immediately after the virtual machine's window turns black and the VMWare logo appears in the window, 
click on the VMWare logo to set the cursor focus inside the virtual machine and then press F2 to enter the 
BIOS setup options. 

22. In the PhoenixBIOS Setup Utility, use the arrow keys on the keyboard to move to the Boot section of the 
utility. 

23. Use the down arrow key on the keyboard to select CD-ROM drive. 

24. Press the plus (+) key on the keyboard to move CD-ROM to the top of the list and then press the F10 
key. 

25. Insert Fedora Core Disk 1 into the CD-ROM drive and start the virtual machine. 

26. When the Fedora Core text splash screen appears, click inside the virtual machine, and then press ENTER. 

27. When the CD Found screen appears, use the arrow keys to select Skip. 

28. When the Fedora logo screen appears, click Next. 

29. In the language selection window, English is selected by default.  Click Next. 

30. In the keyboard selection window, U.S. English is selected by default.  Click Next. 

31. When the Warning dialog appears, informing you that the partition table on the device is unreadable and 
must be initialized, click Yes. 

32. In the partitioning window, click the up and down arrows at the right of the selection box that appears 
after the introductory paragraph. 

33. From the selection menu, choose “Remove all partitions on selected drives and create default 
layout” and then click Next. 
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34. In the Warning window, click Yes. 

35. In the Network Devices section, click the Edit button. 

36. In the Edit Interface eth0 window, unselect Use dynamic IP configuration (DHCP). 

37. In the Edit Interface eth0 window, unselect Enable Ipv6 support. 

38. In th IPv4 Address box, type 10.0.0.3. 

39. In the IPv4 Prefix (Netmask) box, type 255.255.255.0 and then click OK. 

40. In the Hostname section, select manually and in the box to the right, enter LINI. 

41. In the Miscellaneous Settings section, Gateway box, type 10.0.0.254. 

42. In the Primary DNS and Secondary DNS boxes, enter the IP addresses of the primary and secondary 
DNS servers used for the class and then click Next.. 

43. In the time and timezone window, use the up and down arrows to select the proper time zone for the 
computer and then click Next. 

44. In the root password window, enter “password” (without quotes) in the root password box and again 
in the confirm box and then click Next. 

45. In the additional software window, click Next.  Packages and dependencies will be verified. 

46. In the begin installation window, click Next. 

47. In the Required Install Media window, click Continue. 

48. When the Change CDROM window appears, remove Fedora Core CD-ROM #1 from the CD-ROM tray, 
insert Fedora Core CD-ROM #2 and then press OK. 

49. When the installation has finished, click Reboot. 

50. In the Fedora Welcome screen, click Forward. 

51. In the License Agreement window, click Yes.  I agree to the License Agreement and then click 
Forward. 
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52. In the Firewall window, click the up and down arrows, select disabled and then click Forward. 

53. If an untitled dialog appears informing you that clicking “Yes” overrides existing firewall configurations, 
click Yes. 

54. In the SE Linux window, click the up and down arrows, select Permissive and then click Forward. 

55. In the Date and Time window, set the date and time to that of the local area, then click Forward. 

56. In the Create User window, click Forward. 

57. In the untitled warning window, click Continue. 

58. If the computer is equipped with a Sound Card, the Sound Card window will appear.  Make any changes 
necessary and then click Finish. 

59. In the Fedora logon screen, enter the user name root and then press ENTER. 

60. In the Fedora logon screen, enter the password password and then press ENTER. 

61. On the upper Panel, click Applications and then select Accessories --> Terminal from the drop down 
menus. 

62. In the root@LINI:~ terminal window, type shutdown -h now and then press ENTER. 

63. Configuration of the Fedora Core Linux system is now complete. 

 

 

CT#19:  Install/Configure Dynamic Host Configuration Protocol (DHCP) 
  

Install Dynamic Host Configuration protocol (DHCP) 
 

1. Click on Start|Control Panel|Add or Remove Programs. 

2. In the Add or Remove Programs window, click on Add/Remove Windows Components. 
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3. In the Windows Components Wizard page, scroll to Networking Services. 

4. Select Networking Services by clicking on the words.  No not click in the check box to the left of Networking 
Services. 

5. Click Details. 

6. Click the check box to the left of Dynamic Host Configuration Protocol (DHCP) to select. 

7. Click OK and then click Next. 

8. When the Optional Networking Components dialog appears informing you that the computer has a 
dynamically assigned IP address, click OK to assign a static IP address to the Instructor computer. 

9. In the Local Area Connection Properties window, click on Internet Protocol (TCP/IP) to select it 
and then click Properties. 

10. In the Internet Protocol (TCP/IP) Properties window, General tab, click on Use the following IP 
address: and enter the following information: 

 IP Address:  10.0.0.250 
 Subnet Mask:  255.255.255.0 
 Default Gateway:  10.0.0.254 

11. In the Internet Protocol (TCP/IP) Properties window, General tab, click on Use the following DNS 
server addresses: and enter the IP addresses of your external DNS servers. 

12. Click OK. 

13. In the Local Area Connection Properties window, click Close. 

14. When the Completing the Windows Components Wizard page appears, click Finish. 

15. Close the Add or Remove Programs window. 

 

Configure Dynamic Host Configuration Protocol (DHCP) 
 

1. Click on Start|Administrative Tools|DHCP. 
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2. In the DCHP window, expand instructor [10.0.0.250] icon. 

3. Right click on the instructor [10.0.0.250] icon and select New Scope from the pop up menu. 

4. In the Welcome to the New Scope Wizard window, click Next. 

5. In the Scope Name window, in the Name box, type CEH and then click Next. 

6. In the IP Address Range window, Start IP address box, type 10.0.0.20. 

7. Press TAB to move the cursor to the End IP Address box and type 10.0.0.199. 

8. Press TAB to move the cursor to the Length box and type 24.  The subnet mask box will automatically 
display the subnet mask of 255.255.255.0. 

9. Click Next. 

10. In the Add Exclusions window, click Next. 

11. In the Lease Duration window, click Next. 

12. In the Configure DHCP Options window, click Next. 

13. In the Router (Default Gateway) window, in the IP address box, type 10.0.0.1, then click on Add and 
Next. 

14. In the Domain Name and DNS Servers window, click in the IP address box, type the IP address of your 
primary DNS server and click Add. 

15. In the Domain Name and DNS Servers window, click in the IP address box, type the IP address of your 
secondary DNS server, click Add and then Next. 

16. In the WINS Servers window, click Next. 

17. In the Activate Scope window, click Next. 

18. In the Completing the New Scope Wizard window, click Finish.. 

19. Close the DHCP window. 

 

CT#20:  Install Microsoft Office components 
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Note:  This setup guide shows how to install the required components of Office 2000.  Installation of Office 
XP or office 2003 components will be similar. 

1. Insert the Office 2000 CD into the CD-ROM drive. 

2. If the Windows Installer does not start automatically, open Windows Explorer, navigate to the root of the 
CD-ROM drive, and click on setup.exe. 

3. When the Welcome to Microsoft office 2000 window appears, click Next as the user name and organization 
fields are already populated. 

4. In the Microsoft Office 2000 End-User License Agreement window, click I accept the terms in the 
License Agreement and click Next. 

5. In the Microsoft Office 2000:  Ready to Install window, click Customize. 

6. In the Microsoft Office 2000 Installation Location window, click Next. 

7. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft Word and select Run from My Computer from the pop up menu. 

8. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft Excel and select Run from My Computer from the pop up menu. 

9. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft PowerPoint and select Run from My Computer from the pop up menu. 

10. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft Outlook for Windows and select Not Available from the pop up menu. 

11. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft Access and select Not Available from the pop up menu. 

12. In the Microsoft Office 2000:  Selecting Features window, click on the disk icon to the left of 
Microsoft FrontPage and select Not Available from the pop up menu. 

13. Do not make any changes to Office Tools and Converters and Filters icons and click Install Now. 

14. When setup has completed, and the Microsoft Office 2000 Setup window appears, click OK. 
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Remove the default “Internet Explorer Enhanced Security Configuration” 
utility 

 
1. Click Start  Control Panel  Add / Remove Programs 

2. Click Add/Remove Windows Components 

3. Windows Configurations Wizard is shown 

4. Scroll down and uncheck Internet Explorer Enhanced Security Configuration 
5. Click Next 
6. Click Finish 

 
 
Disable DEP in Control Panel 

1. Click Start  Control Panel  System 
2. Click Advanced 
3. Click Settings button 
4. Click the radio button Remove the default “Internet Explorer Enhanced Security Configuration” utility 
5. Click OK 
6. Click OK to close the System Properties Window 

 
 

Install Firefox Browser 
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1. Visit the website http://www.mozilla.com/firefox 
2. Follow the instruction on the screen to download and install Firefox Browser 

 
 

Install Microsoft ISA Server 
1. Using Microsoft Small Business Server CD-ROM, install the ISA with all default settings 

 
 

End of Document 


